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Good Morning! 
 Day 2 

Student Writing & 
Technology 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
“Computers are intrinsically compelling for young children. The sound and 
graphics gain children’s attention. Increasingly, young children observe adults 
and older children working on computers and they want to do it too. Children get 
interested because they can make things happen with computers. 
Developmentally appropriate software engages children in creative play, 
mastery learning, problem solving, and cooperation.” 

NAEYC “Technology and Young Children—Ages 3 through 8” 1996 
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Learning Letters 
 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Question for Teachers: 
Can I effectively use one computer as an instructional 
tool in my classroom? Can I teach letter identification 
using a free downloadable resource? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
http://www.r
iverdeep.com
/products/do
wnloads/free
_downloads.j
html 
 
Additional 
Cihicka Chika 
Boom Boom 
Resources 

http://www.a
tozteacherst
uff.com/less
ons/ChickaCh
icka.shtml 

Instruction 
Essential Question for the Lesson: 
Can students identify the letters the alphabet? 
 
Learning Goal(s): 
Students will identify the upper and/or lowercase 
letters. 
 
Technology Connection: 
One Internet connected computer 
Downloadable program Letter Machine from Riverdeep 
 
Materials: 
A copy of Chicka Chicka Boom Boom 
Laminated alphabet letter cards 
1 copy of the of activity sheet per child 
 
Procedures: 

1. Download and install the Letter Machine program 
from Riverdeep on all of the computers you will be 
using. See Quick Tip Sheet for directions. Make 
sure that the computers have sound and are 
adjusted to the right level or that ear phones are 
available. 
Create a big coconut tree with upper and/or lower 
case letters on it all mixed up. Before you 
introduce the activity, hang the tree where it will 
easily be seen. Make alphabet letter cards and 
laminate them. 

http://www.riverdeep.com/products/downloads/free_downloads.jhtml�
http://www.riverdeep.com/products/downloads/free_downloads.jhtml�
http://www.riverdeep.com/products/downloads/free_downloads.jhtml�
http://www.riverdeep.com/products/downloads/free_downloads.jhtml�
http://www.riverdeep.com/products/downloads/free_downloads.jhtml�
http://www.riverdeep.com/products/downloads/free_downloads.jhtml�
http://www.atozteacherstuff.com/lessons/ChickaChicka.shtml�
http://www.atozteacherstuff.com/lessons/ChickaChicka.shtml�
http://www.atozteacherstuff.com/lessons/ChickaChicka.shtml�
http://www.atozteacherstuff.com/lessons/ChickaChicka.shtml�
http://www.atozteacherstuff.com/lessons/ChickaChicka.shtml�
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Individual or 
Pair 
 
 
 

 
 
http://www.d
ltk-
kids.com/boo
ks/chicka/ 
 
 
 
 
 
 
 
 
 
 
 

Prepare the computer by connecting it to a 
television or a projector. 

2. Have the students come and sit where they can 
see the chart and also see the computer. Cover the 
chart so that it is not immediately visible. 

3. Tell the students that you have a story for them 
today.  Show them the cover and read the book.  
Discuss what happened in the story. The students 
should tell you that the story is about letters 
climbing a tree and falling out. 

4. Hand out the letter cards to the students and 
read the story a second time having them come up 
and place the cards on the coconut tree and take 
the letters back off the tree. Retrieve all the 
letters and put them away. 

5. Now tell students that you have a letter game for 
them to play. Turn on the monitor and introduce 
Letter Machine. Show the students how to start 
the game and then have them in pairs rotate 
through the game as a center. Each member of the 
pair should complete a different activity sheet. 
Emphasize to the students that the drawings 
should be quick pencil sketches not fully rendered 
pictures. 

6. This activity can be done more than once by 
changing the letters in the activity sheet or 
focusing on the ends of words rather than the 
beginnings of words. Use the assessment provided 
to see how students are doing with identifying 
letters. Teachers may want to laminate the 
assessment and have students use wipe off 
markers on the laminated copy. In this case record 
their results on a separate piece of paper. 

 

http://www.dltk-kids.com/books/chicka/�
http://www.dltk-kids.com/books/chicka/�
http://www.dltk-kids.com/books/chicka/�
http://www.dltk-kids.com/books/chicka/�
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Letter Machine Activity 
 
Name__________________________ 
 
Draw a picture of the animal that goes with each letter. 
 
     Letter          Picture 

f  
g  
k  
r  
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Letter Machine Activity 
 
Name__________________________ 
 
Draw a picture of the animal that goes with each letter. 
 
     Letter          Picture 

b  
h  
t  
p  
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Letter ID Assessment 
 
Name ________________________  Date____________ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
C   M   T   R 

 
A   P   L   G 

 
K   D   O   N 

 
E   B   W           U 

 
I   J   Q   Y 

 
S   V   H   X 

 
    Z   F 
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 Downloading &  
Installing Programs 

 
1. Type in the address or URL of the program you want to download into 

your browser’s address window. Press the Enter or Return key on your 
keyboard and wait for the web site to load. 

2. Read the information provided on the site to make sure that you choose 
the version of the program that is right for your computer. That usually 
involves choosing MAC or PC. If you are using PC, check to make sure 
whether the program will work on Win 95/98, Win 2,000, Windows ME, 
or Windows XP. 

3. Click the correct version and you will be prompted as to whether you 
want to open the program or save it. Choose to save the program and 
then choose where you want to save it. If you have the option, save it to 
the desktop so that it will be easy to locate. Look at the name of the 
program so it will be easy to locate. 

 

 
 

4. Depending on your connection it may take a few minutes for the 
program to download. When it is finished, close your Internet 
connection and any other open files on your computer.  Locate the 
program. 
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5. Double click to install the program and follow the directions. Usually an 
installation wizard walks you through the process of actually installing 
the program. 

6. You may have to restart the computer before using the program. Test 
to make sure it is working prior to using it with students. 
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Brown Bear, Brown Bear What Do You See? 
 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Question for Teachers: 
Can I create a reading resource for my students? 
Can I use a software program to teach students to 
recognize names? Can I create a slideshow using Kid 
Pix? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Essential Question: 
Can I recognize patterns in stories? 
Can I learn the names of my friends? 
 
Learning Goals: 
Students will identify the pattern in the story. 
Students will create a new version of this story with 
their names. 
Students will type their name and the name of a 
friend into a template. 
 
Materials: 
1-3 computers with Kid Pix software 
 
Preparation: 
Make sure that Kid Pix is installed on all of the 
computers you will be using. 
Determine where you need to save the student’s files 
so that they all can be pulled into a slideshow. 
Make copies of the prep sheet for each student. 
 
Procedure: 

1. Organize the students so that they can see the 
computer and are sitting in a circle. Make copies 
of the prep sheet for the slide show for each 
student. 

2. Introduce the story Brown Bear, Brown Bear. 
Ask students if they have heard it before. 



Ready for Reading, Technology Tools in the Early Elementary Classroom                                      Day 2 

Copyright © 2004-2009 i3 Training Services Inc.                  inspiring,  innovative,  instruction     11 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Individual 

3. Tell them that today when they hear it you want 
them to listen to the pattern in the story. Read 
the story slowly encouraging the students to 
chime in when they understand the pattern. 

4. When you are through reading the story, have 
the students articulate the pattern in the 
story. Tell the students that they are going to 
make a new story that will be similar to Brown 
Bear, but instead of the animals being the stars 
of the story that they are going to stars in the 
story. Begin the new story by using their names 
in place of the animals. Tell the students that 
they always say the name of the person next to 
them as they go around the circle. Explain to 
the children that because we are talking about 
people we will use the word "who" instead of 
"what" in the story. 

      Example: 
Madeline, Madeline who do you see? 
I see Griffin looking at me. 

5. Now tell the students that they are going to 
create a slide with their names for this story. 
Turn on the monitor and open up the template 
for the brown bear story. Demonstrate what 
the students will do by filling    in the template 
with your name and the name of the student 
sitting next to you. Have students on the 
bottom of the template create a picture of 
their face. 

6. Finally demonstrate how to save the picture and 
tell the students how they should get the next 
student to do their slide.  

7.  Hand out the prep sheet and go over it with the students. 

Have the students write their name. Have the person sitting 

next to them write their name in     

  the blank provided so that students are  ready when they get to the computer. 
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8. Have students either one at a time or in pairs 
create their slide in Kid Pix and save it.  When 
they are done, pull all the slides into a slide 
show and share the new story with the class. 
Have them join in as you read the story. 
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Brown Bear Prep Sheet 
 
Name___________________________________ 
 
 
 

_____________ ______________who do 
you see? 
 
I see _________________ looking at me.  
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Slideshow Quick Tips 
Kid Pix Studio Deluxe Steps 

 
Getting Started: 
1.  Have a blank floppy disk prepared on which to save slides. 
 
2.  Open Kid Pix Studio Deluxe.  From the Picker menu, choose Kid Pix. 
  
To Create a Title Slide: 
 
1.  Add a background: 

• Click the Paint Bucket Tool.  Select a color from the Color Palette.  
Select a pattern from the Options Tray.   Move the Paint Bucket onto 
the page and click. 

 
2. Add a title: 

• Click the Typewriter Tool.  Select a font, size, and style from the 
Options Tray.  Scroll to choose a font or double-click the font window 
to choose a font from a list.  Select a color from the Color Palette.  
Click to plant the cursor on the screen.  Begin typing.   

 
3.   Editable text is a new feature available in Kid Pix Studio Deluxe.  Text 

boxes float above the background, making them easy to edit and move.  
Simply click the Typewriter Tool and then click to select a text box.  You 
may now change the font, size, color, etc. or move the text box by clicking 
and dragging.  To edit text, click to plant the cursor.  Then backspace over 
text to remove letters or words.  Type to add text.  It’s that easy!   

 
4. If you are NOT using the Deluxe version of Kid Pix Studio, you do NOT have 

editable text boxes.  Follow the steps below to center the title. 
 

5.  Center the title: 
• Click the Moving Van Tool.  Click the Magnet in the Options Tray.  

Your cursor will become a +.  Move the + to the upper left portion of 
the title.  Click, hold, and drag to select the title.  You will see 
marching ants around the title.  Click in the middle of the title (you 
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will see the magnet), hold and drag the title until it appears centered.  
Follow the same procedure to center any other text.   

 
6.  Fill in white spaces: 

• Click the Eyedropper Tool.  Move the Eyedropper onto the background 
and click.  This tool picks up the exact color of the background.  Now 
click the Paint Bucket.  Move the Paint Bucket to white areas and click 
to fill with background color. 

 
7.  Add a second row of text:  By _________ 

• Click to plant the cursor in the desired location on the screen.  Choose 
a font, size, color, and style.  Begin typing. 

 
8.  Resize text boxes: 

• Click one of the red handlebars on the text box.  Click, hold, and drag 
to resize. 

 
9. Hear text read aloud: 

• Under the Speech Menu, choose Read Text Aloud.  (This feature will 
not work if text is painted to the background.) 

 
• If a word is mispronounced, you may edit the speech by choosing How 

to pronounce from the Speech Menu. 
 
10.  Paint text to background: 

• Text boxes float above the background.  You may choose to affix the 
text boxes to the background.  Click the Typewriter Tool.  Under the 
Toolbox Menu, choose Paint Text to Background.  You may paint only 
the active text box, or all text boxes to the background.  When you 
paint the text to the background, it may no longer be edited!!  In 
addition, if text is painted onto the background, it may not be read 
aloud! 

 
11.  Record a sound: 

• Under the Goodies Menu, choose Record a Sound.  Click the Record 
Button.  Record your text for the title slide.  Click the Stop Button.  
Click the Play Button to preview the recording.  Click Save. 
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12.  Decorate the title page: 
• Click the Rubber Stamp Tool.  Under the Goodies menu, pull down to 

Pick a Stamp Set.  Scroll down until you see the Nature stamp set.  
Click to choose the Nature stamp set.  Click OK. 

 
• Scroll through the Options Tray to find stamps of ocean animals.  

Click to select the stamp you wish to use.  Your cursor will become the 
stamp.  Move the stamp onto the page in the desired location.  Click to 
place stamp.   

 
13.  Enlarge stamps: 

• Press the Control key to make the stamp one size larger.  While the 
Control key is pressed down, click to stamp. 

• Press Control and Shift to make the stamp even larger.  Click to stamp 
while holding down Control and Shift. 

 
14.  Edit a stamp: 

• Click to select the stamp you wish to edit.  Under the Toolbox menu, 
click Edit A Stamp.  You may flip the stamp, draw on it, paint it a 
different color, etc.  When you are finished editing, click OK.  Click to 
stamp.  When you are finished with that stamp, go back to Edit A 
Stamp under the Toolbox menu.  Click Restore Original to restore the 
stamp to its original position and color.  Click OK.  You may also 
double-click the stamp in the Options Tray to access the stamp 
editor. 

 
15.  Save slide 1: 

• Select Save a Picture under the File menu.  Choose a location in which 
to save.  (floppy disk - A drive)  Name your picture (slide1).  Select 
Save Sound.  Click OK. 

 
To Create New Slides: 
1.  Add a new page: 

• Choose New from the File menu. 
 

2.  Add a background:   
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• Click the Paint Bucket Tool.  Select a color from the Color Palette.  
Select a pattern from the Options Tray.   Move the Paint Bucket onto 
the page and click. 

 
3.  Draw a picture: 

• Use the Pencil Tool to draw a picture on the page.  Notice you have 
two Option Trays - one has a blunt pencil point, one has a rounded 
pencil point. Make sure all lines are connected.  Fill your picture using 
the Paint Bucket. 

 
4.  Erase: 

• Use the Eraser Tool’s first four options to erase small mistakes.   
• The remaining options in the Options Tray will erase the entire page.   
 

5.  Undo: 
• Click the Undo Man to undo your last operation if you make a big 

mistake.   
 

6.  Add text:   
• Click the Typewriter Tool.  Select a font, size, and style from the 

Options Tray.  Scroll to choose a font or double-click the font window 
to choose a font from a list.  Select a color from the Color Palette.  
Click to plant the cursor on the screen.  Begin typing.   

 
7.  Record a sound: 

• Under the Goodies Menu, choose Record Sound.  Click the Record 
Button.  Record your text for the title slide.  Click the Stop Button.  
Click the Play Button to preview the recording.  Click Save. 

 
8.  Save slide : 

• Select Save a Picture under the File menu.  Choose a location in which 
to save.  (floppy disk - A drive)  Name your picture (slide2).  Select 
Save Sound.  Click OK. 

 
To insert a graphic from an outside source: 

• From the File Menu, choose Import a Graphic. 
• Find a graphic that you wish to use.   
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• You will see a preview of the graphic on the left side of the Import a 
Graphic window.  You may rotate the graphic by clicking the rotate 
arrows below the graphic preview. 

• Choose to position the graphic on the drawing area by selecting one of 
the following options: 
 Fill Screen will make the graphic fill the entire drawing area  
  (picture may get distorted). 
 Scale to Fit will make the graphic fit the drawing area   
  proportionally. 
 Center will place the graphic in the middle of the drawing area.      

                    It will appear in its original size. 
 Upper Left will place the graphic in the upper left corner of the 
  drawing area.  The graphic will appear in its original size. 
 Scale Manually will enable you to move and resize the graphic by 
  hand. 
 
* Scale manually is an option available only in Kid Pix Studio Deluxe. 
 
• Choose Scale Manually.  Click OK. 
• Move the graphic by clicking, holding, and dragging from the center of 

the graphic.   
• Resize the graphic by clicking, holding, and dragging from one of the 

blue handlebars.  Drag inward to reduce the size of the graphic.  Drag 
outward to increase the size of the graphic. 

• Position the graphic.  Click outside the graphic area to place graphic 
on page. 

 
3.  Select a background color: 

• Choose the Eyedropper Tool.   Click a desired color on the graphic to 
choose a background color.  This places the desired color on the Color 
Palette. 

 
4.  Add a background: 

• Choose the Paint Bucket Tool.  Your selected color should be on the 
Color Palette.  Click to paint the background. 

• Some graphics may have a white border around them.  If this is the 
case, you may use the Paint Bucket Tool to fill in the white border.  
Occasionally, paint will bleed into your graphic.   You may choose to 
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frame the graphic.  Choose the Rectangle Tool, and the Transparent 
Option in the Options Tray.  (Transparent Option is the third one 
from the left.)  Click, hold, and drag to draw a rectangle around the 
graphic.   

 
5.  Add text:   

• Click the Typewriter Tool.  Select a font, size, and style from the 
Options Tray.  Scroll to choose a font or double-click the font window 
to choose a font from a list.  Select a color from the Color Palette.  
Click to plant the cursor on the screen.  Begin typing.   

 
6.  Record a sound: 

• Under the Goodies Menu, choose Record a Sound.  Click the Record 
Button.  Record your text for the title slide.  Click the Stop Button.  
Click the Play Button to preview the recording.  Click Save. 

 
7.  Save slide: 

• Select Save a Picture under the File menu.  Choose a location in which 
to save.  (floppy disk - A drive)  Name your picture (slide3).  Select 
Save Sound.  Click OK. 

• Select Save a Picture under the File menu.  Choose a location in which 
to save.  (floppy disk - A drive)  Name your picture (slide4).  Select 
Save Sound. Click OK. 

 
To pull slides into a slideshow: 
 
1.  Insert the slides 

• Under the File menu, choose Return to Picker. 
• Click Slideshow. 
• In the first moving van, click the picture button (lower left, beside 

the music note).   
• Insert slide one. By navigating to the disk or folder where the slides 

are located, clicking on the slide and then clicking OK. 
• Continue until slides have been added to the slideshow. 

 
2.  Choose or add sound: 

• Click the music button on the first moving van.  
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• Choose a sound.   
The black box contains Kid Pix sounds. 
The abc option selects the computer voice to read story to you.  
  (Available only in Kid Pix Studio Deluxe.)  
The Kid Pix option selects a sound you recorded while in Kid Pix. 
The microphone option enables you to record a sound now. You have 16 
seconds for a recorded sound. You may choose More Sounds to 
access.wav files and import a sound. You may choose no sound. 

• Click Select. 
• Follow the above steps to add sound to remaining slides. 
 

3.  Add transition: 
• Click the transition button to the right of the music note.   
• Click to select a transition. 
• Click preview to view the transition. 
• Click Select. 
• Follow the above steps to add transitions to remaining slides. 

 
4.  Add a second sound to the ending slide: 

• On slide four, record a sound “The End.” 
• Choose a scissors transition. 
• For the fifth moving van, import slide four again.   
• Choose a different sound for this slide - hands clapping, for example. 
• When the slide show plays, you will hear “The End” followed by 

applause. 
 

5.  View or change time for each slide: 
• Click and hold the gray button on the time slide bar to view the 

current time elapsed for that slide.  The time slide bar is below the 
truck.  Click the gray button to the right of the yellow mark. 

• Click and drag the gray button to increase or decrease the time for 
each slide.  Slide will play for at least the length of the time the 
sound plays, with a maximum of 30 seconds per slide. 

 
 
6.  Rearrange slides: 

• Click and drag the moving van to the desired location to rearrange 
slides. 
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7.  Delete a slide: 

• Click to select the slide you wish to delete.   
• Click the dynamite. 
 

8.  Undo your last operation: 
• Click the undo man immediately. 
 

9.  View slide show: 
• Click the triangle button at the bottom of the screen to view the slide 

show once.  
• Click the boxed triangle to play the slide show looped.  Double click to 

stop the looped slide show. 
 

10.  Save slide show: 
• File menu - Save a Slide Show - make sure Kid Pix pictures (.bmp 

files) and slide show are saved in the same location.  You will need 
Kid Pix Studio software to run this slide show.  This saving option 
enables you to edit the slide show. 

• File menu - Save an AVI - saves your slide show as a movie file, which 
may be viewed in Wacky TV. 

• File menu - Save a Standalone - saves your slide show by itself.  It 
saves the slide show as an executable file, with a .exe extension.  It 
will run without Kid Pix Studio software; however, you will not be able 
to edit. 
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Two Anansi Tales 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Question for Teachers: 
Can I use a word processing program to create a Venn 
Diagram? Can I use Kidspiration to respond to student 
literature? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Teaching with 
one computer 
and a 
projection 
device to 
explore 
literature 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Electronic 
literature 
from the 
Internet 
 
 
http://www.
bookhive.org
/zingertales
/default.asp

Essential Questions: 
Can students listen and respond to digital literature? 
Can students use a children’s program to respond to 
literature? 
 
Learning Goals: 
Students will listen and read electronic literature. 
Students will participate in discussion about the story.  
Students respond to the story. 
Student will create and describe an original character. 
 
Prior Knowledge: 
Students need to be familiar with Anansi 
 
Technology Connections: 
One computer with Internet connectivity 
Kidspiration 
MS Word 
 
Preparation: 
Make sure that both stories work on the computer you will 
be using them on and that the Real Player  Plug-in is 
loaded. 
 
Procedures: 

1. Create a Venn Diagram in MS Word and have it 
ready to use. 

2. Have students come, sit and be ready to participate. 
Introduce the activity by telling students that they 
are going to watch two stories today and you want 

http://www.bookhive.org/zingertales/default.asp?storyid=16�
http://www.bookhive.org/zingertales/default.asp?storyid=16�
http://www.bookhive.org/zingertales/default.asp?storyid=16�
http://www.bookhive.org/zingertales/default.asp?storyid=16�
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1 computer 
classroom 

?storyid=16 
 
http://www.
bookhive.org
/zingertales
/default.asp
?storyid=17 
 
 
 
http://www.
bookhive.org
/ 
 
 
 
 
 
 
 
 
 
 
Venn 
Diagram in 
MS Word 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

them to pay careful attention and be ready to talk 
about the stories. 

3. Open the first story “Anansi and the Two Feasts” 
and play the first story.  

4. Bring up the Venn Diagram. Tell the students that 
they just heard the first story and that you want 
them to think about the story and help to describe 
it. Introduce the Venn Diagram and type the word 
title of the story over one circle. Show them where 
the two circles overlap and explain to them that 
some things about the stories are different and 
some are the same. Tell the students that the parts 
that are different we will write in the part of the 
circle that is not overlapped. If the two stories 
have something in common we will put that in the 
area where the circles overlap. 

5. Open the second story which is “Anansi and the 
Shaking Hat Dance” and play it. Again talk with the 
students about what makes them feel scared. 

6. Bring the Venn diagram back up and then type the 
title of the second story over the second circle. 
Add 1-2 word descriptors of the items the students 
mention into the second circle. When the students 
bring up something that the stories have in common 
and make sure to put it in the right place.  

7. To finish the activity today review the Venn 
Diagram and read the words the students 
contributed. Quiz the students to see if they can 
read the words with you. Then tell the students 
that they are to choose a word and create a picture 
of something that makes them feel that way.  

8. On day 2 begin the lesson by asking the students 
which stories they read yesterday.  

9. Tell them that today we are going to talk about the 
main character. Explain that the main character is 
the one that the story is about. See if they can tell 
you Anansi, it not supply it. Open Kidspiration and 
type Anansi into the main symbol and then have 

http://www.bookhive.org/zingertales/default.asp?storyid=17�
http://www.bookhive.org/zingertales/default.asp?storyid=17�
http://www.bookhive.org/zingertales/default.asp?storyid=17�
http://www.bookhive.org/zingertales/default.asp?storyid=17�
http://www.bookhive.org/zingertales/default.asp?storyid=17�
http://www.bookhive.org/�
http://www.bookhive.org/�
http://www.bookhive.org/�
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Kidspiration 
 
 
 
 
 
 
Additional 
Anansi Links 
 
http://www.
anansi.org/
webwalker/s
tory1.htm 
 
http://www.
anansispace
works.com/ 
 

them use their words to describe Anansi. Talk about 
the way that Anansi thinks and acts makes him 
unique. As you are doing this verbalize what you are 
doing on the computer so that kids learn how to 
work the program. 

10. Tell the students that they are going to get to 
describe a character that they would like to draw a 
picture of and tell a story about. Open a new 
Kidspiration. Change the font so that everyone can 
see the words and create lists of descriptive words 
that the kids might use in their own writing. 

11. To complete this activity have the students use the 
handout to think and draw their character. Then one 
at a time assist the students to come up and using 
Kidspiration, describe their character. 

12. Having students dictate a story is the next natural 
extension of this lesson. 

 

 

http://www.anansi.org/webwalker/story1.htm�
http://www.anansi.org/webwalker/story1.htm�
http://www.anansi.org/webwalker/story1.htm�
http://www.anansi.org/webwalker/story1.htm�
http://www.anansispaceworks.com/�
http://www.anansispaceworks.com/�
http://www.anansispaceworks.com/�
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Name_____________________________ 
 
M 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

My character’s name is 
 
__________________________________________________

____________________.
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 Venn Diagrams in Microsoft Word 
Step by Step 

Setting Up 
• Open Microsoft Word 
• Change the page layout 
• Click on the File menu and select page setup. 
• Click on the Paper size tab. 
• Under Orientation, click the bullet box beside Landscape. 
• Click OK. 
• Change the Zoom. 
• Click the drop down list indicator beside 75% on the right side of the 

toolbar.   
• Select 50%. 
• Make sure your drawing tool bar is showing. 
• Click on the View menu and select Toolbars. 
• If Drawing is not checked, click on Drawing.  If it is, click off. 
 

Making the Venn diagram 
• Draw a circle 
• Select the Oval tool on the drawing toolbar. 
• Hold the shift key while clicking and dragging a circle on the left half of the 

page. 
• Make a copy for a matching circle. 
• Click once on the circle to select it.  (It will have handlebars if it is 

selected.)   
• Right click and select copy. 
• Click off of the circle.  Right click and select paste. 
• Move the new circle over to the right of the page by clicking and dragging so 

that the new circle overlaps the original, allowing room to enter similarities 
in the overlapping area. 

• Set the Circle for No Fill. 
• Right click on the Right circle. 
• Select Format AutoShape. 
• Under Fill, beside Color: Use the drop down list indicator and select No Fill. 
• Click OK. 
• Draw lines for each animal name. 
• Select the line tool from the Drawing toolbar. 
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• Hold Shift while you click and drag a straight line just outside of the upper 
left of the left-hand circle. 

• With the line selected (handlebars on each end of the line) click the Edit 
menu and select copy.  Click again on the edit menu and select paste. 

• Click and drag the new line just outside the upper right of the right-hand 
circle. 

• Add text boxes 
• Select the Text Box tool from the Drawing toolbar. 
• Click and drag a text box above each label line, in each individual circle, and 

in the shared area.  Set the font style and size of your choice in each box.  
(You will have to re-select the text box tool each time.) 

• Right click on the edge of each text box and select Format Text Box. 
• Under the line section on the Colors and Lines tab, change the color to No 

Line.  
• Click OK. 
• Add labels at the bottom of the diagram 
• Again select the text box tool from the Drawing toolbar. 
• Draw a text box under the left circle. 
• Set the font style and size and type “Different.” 
• Right click on the edge of the new text box.  Set the line color to No Line. 
• Draw 2 more text boxes; One for the middle section which will be “Same” 

and the other for the right-hand circle which will be “Different.” 
• Save the Venn Diagram as a template 
• Click on the File menu and select Save As. 
• Change Save as type to Document Template. 
• Change the file name to Venn Diagram. 
• Change the location to 3 ½ Floppy (A:) 
• Click Save. 
• Close out of Microsoft Word. 
 
Using the Venn Diagram Template 
• Open the Venn Diagram Template to enter information. 
• Double click on My Computer. 
• Double click on 3 ½ Floppy (A:). 
• Double click on Venn Diagram.dot 
• Click in the appropriate area to enter information. 
• Save the new Document 
• Click on the File menu and select Save. 
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• Type in the name for the completed Venn Diagram. 
• Change to the appropriate drive and folder. 
• Click Save. 
• Close out of Microsoft Word. 
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Choosing Software 
Not all software is created equal. There are three broad categories of 
software that are used with young students.  
 
Productivity Software 
Software that allows students to write, draw, paint, and/or create. The 
software does not have a lot of specific activities that students do, but rather 
allows students to do all kinds of assignments all year long. 
 
Skills Oriented Software 
Software with specific activities that students do and progress through 
graduated levels. The software is limited in what you can do with it. The 
software may or may not include student tracking options or teacher 
customizing options. 
 
Subject/Topic Specific Software 
There is a lot of software that is designed to address a specific subject. The 
activities are all geared to developing ability in the subject. Frequently, the 
software combines a mix of games, multimedia, and activities. 
 
The advantage to using software with young children is that you have control 
over what is available to them. The disadvantage is that each software package 
provides only a limited amount of things for students to do. Before purchasing 
software, evaluate whether it will meet the needs of the kids in your class and 
for how long. The story CD that looks like a lot of fun may only have 5-6 
activities, which only have 1 or 2 levels. The material provided may not fit with 
what you are trying to do. In a short period of time that software is no longer 
of interest to the students. Read software reviews and talk with colleagues 
before requesting new software titles. 
 
Kids Domain Software Reviews 
http://www.kidsdomain.com/reviews/listing.php?cid=software 
 
Super Kids Educational Software Review 
http://www.superkids.com/ 
 
Discover Channel Software Review 
http://school.discovery.com/parents/reviewcorner/ 

http://www.kidsdomain.com/review/kdr.html�
http://www.superkids.com/�
http://school.discovery.com/parents/reviewcorner/�
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Reading Rebus Rhymes 
 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Question for Teachers: 
Can I effectively use one computer as an instructional 
tool in my classroom? Can I teach rhyming using 
Internet resources? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Whole group 
instruction 
 
One 
computer 
classroom 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
http://www.en
chantedlearnin
g.com/Rhymes.
html 
 
 
 
 

Essential Question: 
Can students identify rhyming words? 
Can students read rebus rhymes? 
 
Learning Goals: 
Students listen and identify rhyming words. 
Students read aloud rebus rhymes. 
 
Materials: 
One computer with Internet connectivity 
 
Preparation: 
Test the link and make sure it is working. 
Create small groups of 3-4 students to do this activity. 
 
Procedure: 
 

1. Organize children so that they can see the 
computer.  Have the link ready on the computer 
but the monitor turned off so that the students 
cannot see images on the screen. Copy the 
Rhyming Words I or Rhyming Words II 
worksheet. 

2. Introduce the activity by asking the students if 
they know what rhyming means. If they are 
unsure, explain that they are words that sound 
alike and give them several examples. 

3. Tell them that they are going to do a listening 
activity. Tell the students that they will be 

http://www.enchantedlearning.com/Rhymes.html�
http://www.enchantedlearning.com/Rhymes.html�
http://www.enchantedlearning.com/Rhymes.html�
http://www.enchantedlearning.com/Rhymes.html�
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listening for words that rhyme and when they 
hear words that rhyme they need to give you a 
thumbs up.  Demonstrate again by saying rhyming 
pairs and non-rhyming pairs and see if they can 
identify the ones that rhyme. 

4. Turn on the monitor and click on the Bees rhyme. 
Read the rhyme together encouraging the 
students to join in and make predictions about 
what comes next.  See if they can identify the 
words that would go with the pictures. Read the 
rhyme again and have the students listen for 
rhyming pairs and give you a thumbs up when 
they hear words that rhyme. Have each child tell 
one rhyming pair. If anyone in the group misses a 
rhyming pair, go back and read the lines again 
and identify the rhyming words with the 
students by asking, “Who can find a word that 
rhymes with ______?” 

5. Click the back button and choose 2-3 other 
rhymes to do the same way. 

6. Conclude the activity by having each student give 
you two words that rhyme that they want to 
illustrate. Write the one word in each box of the 
Rhyming Words worksheet and have students 
take the sheet with them back to the workspace 
so they can complete the illustration. If the 
student is able to come up with an original 
sentence with rhyming words, write it below the 
boxes. 

7. Bring the next group over and repeat the lesson, 
but change the rhymes used.  Teachers may want 
to print some of these rhymes out to place in a 
class book for the students to read. 
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Rhyming Words I 
Name_________________________ 
 

 
 
 

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

___________________________________________________________

___________________________________________________________

___________________________________________________________

___________________________________________________________

___________________________________________________________ 
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Rhyming Words II 

Name_________________________  
Have partner groups create a pair of rhyming words by each child contributing a 
word. 
 

My Word My Friend’s Word 
 
 
 

 

 
 
 

 

 
Rhyming Word Picture 
Using the rhyming words from above create a picture story. 
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Internet Writing 
 

Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Question for Teachers: 
Can I locate and plan an activity with an Internet 
resource? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Small group  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
http://www.sa
ndiegozoo.org/
zoo/ex_panda
_station.html  
 
 
 

Instruction 
Essential Question: 
Can I use an Internet resource to teach writing skills? 
Can students work together to compose a story? 
 
Learning Goals: 
Students will respond to images and develop a group 
story. 
 
Technology Connections: 
One computer with Internet connectivity 
Kid Pix 
 
Preparation: 
Test the link to make sure that it is working. 
Have sentence strips ready and a marker ready for 
writing. 
 
Procedures: 

1. Have the link up and Kid Pix started on the 
computer you will be using. Turn the monitor off. 

2. Have 4-5 students come and sit where they can 
see the computer. 

3. Introduce the activity by asking students what 
types of stories they like to hear. Generate a list 
with them using 1 -2 descriptive words. 

4. Tell them that today they are going to create a 
story. Have them discuss and add elements that 
will make their story exciting and interesting. 

  

http://www.sandiegozoo.org/zoo/ex_panda_station.html�
http://www.sandiegozoo.org/zoo/ex_panda_station.html�
http://www.sandiegozoo.org/zoo/ex_panda_station.html�
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Front page of 
Panda site 
 
 
 
 
Bai Yun Slide 
Show 
 
 
National Zoo’s 
Panda Cam 
http://pandas.
si.edu/pandaca
m/ 
 

5. Tell the students that you have chosen the main 
character of the story and that you have 
pictures to help them get started. 

6. Turn on the monitor and bring up the Panda site. 
The San Diego Zoo page takes visitors to the 
Panda cam. Ask the students if they know what 
animal this is. If they do not, tell them that it is 
a Panda and that pandas live in China. Tell them 
that they are watching the pandas live on the 
screen.  Click on Panda Profiles and read the 
first sentence or two about each panda to the 
students. Do not read the whole description as it 
gets into breeding issues. 

7. Tell the students that their main character for 
their story is Bai Yun. Click on Panda Gallery and 
choose Bai Yun Slide Show. Allow the students to 
watch the slide show run through the images a 
couple of times having the students tell you what 
Bai Yun is doing. Ask the students to think about 
what type of story they would tell about Bai Yun. 
Encourage them to talk about this as a group and 
help them sketch out the bones of a story. 

8. When the students are ready have the first 
student say a sentence, write it on the sentence 
strip. Post it where the whole group can see. 
Have the second student offer a sentence, write 
it on a sentence strip, and place it below the 
first. 

9. When each child has contributed a sentence to 
the story, read through the sentences and talk 
with them about the story they have created. 
Move sentences around or add words to make the 
story flow. Tell the students that their next 
step is to plan the picture for their sentence. 
Take the sentences down. Write the student’s 
name on the back and give them a blank piece of 
paper to plan their picture on. 

10. The next day bring the group back together with 

http://pandas.si.edu/pandacam/�
http://pandas.si.edu/pandacam/�
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their story boards and sentences. Have Kid Pix 
up on the computer but the monitor turned off. 
Lay the sentence strips and story boards out and 
read the story out loud to the students. Then 
introduce the students to the Kid Pix program by 
starting Kid Pix and typing the first sentence in 
using the text tool.  Save the picture with the 
child’s name and PS for panda story on it. If you 
have 2 -3 computers in your class, start other 
students as well. 

11. Have the students raise their hand when they 
have completed the task.  Do not close the 
pictures.  Review them with the students and 
print. 

12.  When the book is complete, have the authors 
share it with the rest of the class along with the 
slide show they used for inspiration. 
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Communicating with Web Pages & Blogs 

 
For communities that have computers and are using the Internet, web pages and 
blogs can be an effective way to stay in touch with parents and showcase your 
student’s talents. Teachers do not need to know html to create pages they can 
share. Simple wizards and online tools allow you to create and update web pages 
easily. 
 
 
Teach-nology Build a Free Web Site 
http://teachers.teach-nology.com/web_tools/web_site/ 
A wizard walks you through the process of creating your own web site. Teach-
nology hosts the site so that teachers do not have to figure out where to post 
their web site. 
 
School Notes. Com 
http://www.schoolnotes.com/ 
Copernicus provides this free resource for creating and hosting teacher-
created web pages. 
 
Scholastic Teacher Homepage 
http://homepage.scholastic.com/classpages/studentparentsignin.cfm  
This site makes it easy for teachers to create and post a web site. 

 
Wordpress Blogs 
http://www.wordpress.com  
 
 

http://teachers.teach-nology.com/web_tools/web_site/�
http://www.schoolnotes.com/�
http://homepage.scholastic.com/classpages/studentparentsignin.cfm�
http://www.wordpress.com/�
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